AN13579

LPC553x/LPC55S3x CoreMark on Cortex-M33 Porting Guide
Rev. 3 — 23 November 2023

Application note

Document information
Information Content

Keywords

AN13579, LPC553x/LPC55S3x, CoreMark, Cortex-M33
Abstract

This application note describes how to port CoreMark code to LPC553x/LPC55S3x, which

involves setting up software and hardware including memory partitioning, compiler setting, and
board setup.
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1 Introduction

Embedded Microprocessor Benchmark Consortium (EEMBC) CoreMark is a benchmark that measures the
performance of microcontrollers (MCUs) and central processing units (CPUs) used in embedded systems. It
contains implementations of list processing (find and sort), matrix manipulation (common matrix operations),
state machine (determine if an input stream contains valid numbers), and cyclic redundancy check (CRC)
algorithms.

LPC553x/LPC55S3x is an ARM Cortex-M33-based microcontroller for embedded applications. These devices
include:

* Up to 128 kB of on-chip SRAM; Up to 256 kB on-chip flash

* FlexSPI with cache and dynamic decryption

* CASPER Crypto/FFT engine

* High-speed and full-speed USB host and device interface with crystal-less operation for full-speed

* One CAN-FD

* One QuadFlash Filter

* One DMIC

* One EZH

* One I13C interface

* Five general-purpose timers, one SCTimer/PWM, one RTC/alarm timer

* One 24-bit Multi-Rate Timer (MRT)

* One OS Timer

* One Micro-tick Timer

* A Windowed Watchdog Timer (WWDT), code Watchdog Timer

* Eight flexible serial communication peripherals (which can be configured as a USART, SPI, high-speed SPI,
12C, or I12S interface)

* Two 16-bit 2.0 Msamples/sec ADCs capable of four simultaneous conversions, four comparators, and two
temperature sensors.

e Three 12-bit 1 Msample/sec DACs

* Three OpAmps,

* Two FlexPWM timers

* Two QEls

The Cortex-M33 offers an 18.2 % performance increase in the same process technology compared to the high
embedded performance bars already established by Cortex-M4 processors while improving power efficiency.
The Cortex-M33 official CoreMark is 4.02 CoreMark/MHz. The Cortex-M4 official CoreMark is 3.40 CoreMark/
MHz.

This application note describes how to port CoreMark code to LPC553x/LPC55S3x, which involves setting

up software and hardware including memory partitioning, compiler setting, and board setup. It also describes
how to measure CoreMark scores on the Cortex-M33 and the results including CoreMark scores and power
consumption in JA/MHz. Separate CoreMark projects for different software development tools (Keil MDK, IAR
EWARM, and MCUXpresso IDE) are also included here for reference.

2 Integration of CoreMark library to SDK2.14 framework

The software package associated with this application note contains an SDK2.14 based project framework. It
allows developers to drop in the CoreMark library sources and quickly get up and running with benchmarking
the LPC553x/LPC55S3x. To get started, follow the link. Click the download link as shown in Figure 1 and follow
the instructions on that page.
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EEMBC Benchn
CoreMark®

An EEMBC Benchmark \bout « FA

What is CoreMark? 1
CoreMark is a simple, yet sophisticated benchmark that is designed specifically to test the functionality of a processor core. Running CoreMark produces a
single-number score allowing users to make quick comparisons between processors.

<« > C ()  https//www.eembc.org/coremark/download g 75 o=
EEMBC Join Benchr
CoreMark®
An EEMBC Benchmark About « FAQ « Dow ad « Scores « Si it Score - Google Grou
Download

CoreMark is now available to license free of charge o{ GitHub! pll previous licenses have been superseded by the Apache license and the Acceptible Usage
disclosure, but please read and be aware of these documents oiiin the repository.

After you have run the software, submit your scores! 2

Figure 1. EEMBC CoreMark download link

After reviewing the license terms, look through the readme file. The readme gives step-by-step instructions on
unpacking and building the distribution. It also helps with getting familiar with the CoreMark terminology used
throughout the application note.

2.1 Port CoreMark library into CoreMark framework

In this application note, there are 4 variants of CoreMark projects for each IDE. There are 2 variants of
execution of the CoreMark application: from internal flash and internal SRAMX.

The variants of CoreMark projects:

1. coremark score on flash executes the CoreMark application from internal Flash.

2. coremark score on sramx executes the CoreMark application from internal RAM.

3. coremark uAMHz on flash measures the current when the CoreMark executes on Flash.
4. coremark uAMHz on_ sramx measures current when the CoreMark executes on RAM.
The CoreMark projects are found in the following locations:

Keil MDK IDE:

lpc55s3x_coremark mdk\ lpc55s3x coremark mdk.uvprojx

IAR Workbench IDE:

lpc55s3x_coremark iar\ lpc55s3x coremark iar.eww

Each of the executing settings has three frequency settings: 12 MHz(FRO), 96 MHz(FRO), 100 MHz(PLL), and
150 MHz(PLL).

Depending on the toolchain, the workspace must look as shown in the following figures. The CoreMark
framework requires the addition of the CoreMark files from EEMBC.
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2.1.1 CoreMark framework for Keil MDK / IAR EWARM / MCUXpresso IDE

The 1pc55s3x coremark xxx project must be set as active before the CoreMark source code files can be

added.

K3 C\Users\nxf75542\OneDrive -

P\ _coremark s

_coremark_mdk.uvprojs - pVision

File Edit View Project Flash Debug Feripherals Tools SVCS Window Help

NS E@| »ad | KX

= I | @ pog

VR# @-lec s a-|@-| A

& 2 ] 9 [psscoremartiasn ] &K | db © 3]
Project 15555 3x_coremark_sram e
= % Project: Ipc35s3x_coremar|Ipcsss3x_coremark_power_flash T EIG
E1 3 Ipcs5six_coremark flash 2 | Copyright 2018 Embedded Microprocessor Benchmark Consortium (EEMBC)
=5 board 3
1) boord 4 |Licensed under cthe Apache License, Version 2.0 (the "License"):
oarde S | vou may not use this file except in compliance with the License.
board.h 6 | You may obtain a copy of the License at
1 clock_config.c 7
0 dlock configh 8 ntep://waw.apache .oxg/licenses/LICENSE-2.0
- B
2 pinmuxe 10 | Unless zequized by spplicable lav or agreed to in writing, software
1 pin_muxh 11 | distributed under the License is distributed on an "AS IS" BASIS,
& cmsis 12 | WITHOUT WARRANTIES OR CONDITICNS OF ANY KIND, either express or implied.
E3 componentlists 13 | See the License for the specific language governing permissions and
14 | limitacions under the License.
4 component/uart =
(3 device 16 | Original Ruthor: Shay Gal-om
& doc 17
* Copyrignt (c) 2017 - 2018 ,
(1 Lpesssag/divers 20 | * 11 rights reserved.
& stortup 21 | */
1] startup_LPC55536.5 22
£ wiies = ssase.
<stdlib.h>
210 coremark 25 "coremark.n"
core_list oin.c 26
core_maine 27 platform */
core_matrix.c e "
- 28
core state.c o
core_utilc 21
core_portme.c 32
ce_printf.c :i .

Figure 2. Keil MDK CoreMark project configuration select
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B8 workspace - Ipc35536_coremark/coremark/part_Ipc3500/core_portme.c - MCUXpresso IDE
File Edit Source Refactor Navigate Search Project ConfigTools Run RTOS Analysis Window Help

(=B 4 B & v @id Qiw|m® - iy RN PRI ERATE S RA R A PR - - - - |
 Proje.. Regis... #Faults % Perip.. ~ ¥ (@ core_portmec

SR R 94 */
v Sl New , efine GETMYTIME(_t) (*_t=barebones_clock())

Go Into #define MYTIMEDIFF(fin,ini) ((fin)-(ini))
RETIMETYPE MYTIMEDIFF(CORETIMETYPE fin, CORETIMETYPE ini)

®
¢

Open in New Window

Show In ARShiftsW> | /= ARM Systick is 24 bits wide down counter */
Show in Local Terminal >

CORETIMETYPE ini_int = ini & @x@FFFFFF;

Copy CUl+C | CORETIMETYPE fin_int = fin & OXQBFFFFFF;
v Paste Ctrl+v
¥ % Delete Delete | return (ini_int - fin_int);
Source .
" Fine TIMER_RES_DIVIDER 1

fine SAMPLE_TIME_IMPLEMENTATION 1
Rename. F2 efine CLOCK_PER_SEC_LPCSS 1600000
fine EE_TICKS_PER_SEC (CLOCK_PER_SEC_LPCSS / TIMER_RES_DIVIDER)

s Import.
& Export.. Define Host specific (POSIX), or target specific global time variables. */
Build Project tic CORETIMETYPE start_time_val, stop_time_val;
Clean Project Function : start_time
Refresh FS5 This function will be called right before starting the timed portion of the benchmark.
Close Project

Implementation may be capturing a system timer (as implemented in the example code)

Close U oject §
Close Unrelated Proje or zeroing some system parameters - e.g. setting the cpu clocks cycles to @

8uild Configurations > SetAcive > ¥ 1 run_on flash (run_on_flash)
Build Targets > Manage.. 2 run_on_sramx {run_on_srams)
Index ’ Build All
Profiing Tools > Cleanal lbe called right after ending the timed portion of the benchmark
© RunAs 4 Build Selected...
% Debug As > ["Implementation may be capturing a system timer (as implemented in the example code)
Profie As > | or other system parameters - e.g. reading the current value of cpu cycles counter.

Restore from Local History...

d stop_time(void)
Launch Configurations

GETMYTIME (&stop_time_val);

49196 2496 8372 60064  eaa@ lpcS5s36_coremark.axf

~ Create orimport a project

w project, 11:45:53 Build Finished. @ errors, & warnings. (took 6s.362ms)

Import SDK examplels).

® |mport proiect(s) from file system. v

Figure 4. MCUXpresso project configuration select

. Utities > . )
@ Function : get_time
@, B SDK Management > | Return an abstract "ticks" number that signifies time on the system
Tools >
“ Validate Actual value returned may be cpu cycles, milliseconds or any other value,
B MCUXpresso Config Tools > | as long as it can be converted to seconds by <time_in secs>.
T e e This methodology is taken to accomodate any hardware or simulated platform
@ & The sample implementation returns millisecs by default,
& Team > | and the resolution is controlled by <TIMER_RES_DIVIDER>
" Compare With >
Configure S = .
OQuicks o , 45DKs O Properties [£ Problems % Progress ©Cansole = & Terminal = Image Info ®Debugger Consle = Offiine Peripherals. 0 Memory © Heap and Stack Usage & Threads (Azure RTOS Threadx) ® |« v1%| LEut = &= @ > o~
Console (Ipc55536_coremark]
Properties AltsEnter LB PUSCTDULIT S L . i i
Mewryp -eabi-size "1pc55s36_coremark.axf'; # arm-none-eabi-objcopy -v -O binary “lpcsSs36_coremark.axf” “1pc55s36_coremark.bin® ; # checksum -p LPCS5536 -d “lpcSSs36_coremark.bin”;
=%/ Project: Ipc55s36_corermark [run_on_flash] text  data bss dec hex filename

Copy the following files from the CoreMark package downloaded from EEMBC:
-core list join.c

-core main.c

-core matrix.c

- core state.c

-core util.c

- coremark.h

Copy the following files from the barebones file:

- core portme.c

- core portme.h

-ee printf.c
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Name Date moddfied

barebones

cygwin

docs 2021/8/27 2:2
freebsd 2021/8/27 2:27
fimux 2021/8/27 2:2
macos 2021/8/27 2:27
posix

rtems

simple

wl core_list_join
w| core_main

w| core_matrix 2021/8/27 2:2
w| core_state 2021/8/27 2:2
wl core_util 2021/8/27 2:2

wl coremark

coremarkmd5

@ LICENSE

Makefile

@ README
«J core_portme 2021/8/27 2:27
<) core_portme 2021/8/27 2:27
core_portme.mak 2021/8/27 2:27
&) ot 2021/8/27 2:27
Iﬂ ee_printf I 2021/8/27 2:27

Figure 5. CoreMark files

For the Keil MDK place, these files are in the project directory 1pc55s3x coremark mdk\coremark.

For the IAR Embedded Workbench place, these files are in the project directory 1pc55s3x coremark iar
\coremark.

For the MCUXpresso place, these files are in the project directory 1pc55s3x coremark mcux\coremark.
For the KEIL MDK project, right-click the CoreMark folder, select Add, then Add Files.
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<l coremark
coremark.mds
@ UCENSE
Makefie 418
L M 19 KB
Bevaea [@ewors | W rancion: | Oy Temon s, W i |

Figure 6. Adding files in Keil MDK

For the IAR Embedded Workbench, right-click the CoreMark folder, select Add, then Add Files.
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@ il utiliies @ LICENSE
L@ i Output Makefile
@ README
<
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] for (1=0: i<iveracions: is+) [
= ze_bench_listives,1);
creulé (ere, rea->ere) ;
I core Tanch liscires -11:
[ Ipesds_comat_ia

T Mew item =

] Easy access -

Hew

»

Froperties
. .

Open
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Open & Select al
Edit Select none
Histoey Irwert selection
Select
- B

Date modified

Ready

Ambiguous Defiritions  Debuglog Build  Find in Files

Figure 7. Adding files in the IAR EWARM workspace

For the MCUXpresso project, copy the files into the source folder. Then click Refresh, the files are added to the

project automatically.
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>
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ol rety - 4 + Coremark » lpeS5s36_coremark_meus » Ipet%s36 coremark > coremark 3 v o
& core_portmeh 187 sdefine . . .
. ; 188 mdefine e Status Date medified
ee_printf.c 165 sdefine o Quicksccess
i cone fist join.c 118 sdefine barebones
CRIe_maing 111 & OneDrive - NP cygwin
ee_rratriec 112 /** Dafi 4
ate.c 113 static { W NOLSSMS e
14 freebsd
il core utile 115 * Funci # Network finux
# coremarch 116 Thij
maces
part_lpe5500
) pasi
121°void sti ems
GETH simple
123 3 rund ol core_list join
i <) core_rain
ol core_matrix
{ 3 core_state
: o) core_util
£ Maledile 138 void sty o coremark
GETH
132 } coremark.md3
device 1 * Funcl @ LICENSE
deivers 134 Rety Makefile
popresso55s36 - acl @ README
Souce 1
as }
startup 1 Thit
utiitses 135 The < =
run_on_flash v 14 4| apitems =l
¢ » 1=
2 Chuickstart Variables * Breakpoi Irstalled SDKs O Properties & Problems SiProgress © Conscle 1 & Terminal & Image Info @ Debugger Consale » Offine Peripherals 0 Mamary ' Heap and Stack Usage @ Theeads [Azure RTOS Thread)
COT Build Console [ipc55s36,_corernark]
o FECTUIMLING PUSL-UBLL0 SLEpS
A MCUXpresso IDE - Quickstart  arm-none-eabi-size "lpcS5536_coremark.axf™; # arm-none-eabi-objcopy -v -0 binary "lpc35s36_coremark.axf™ "lpc55s36_coremark.bin” ; # checksum -p LPCS5536 -
1 Progect: IpcSSs36_coremark frun_on_flash] Text data bss dec hex filename
49196 2496 8372  GoR64 easd lpc55s36_coremark.axf
« Create of impart a project
. 11:45:53 Build Finished. @ errors, @ warnings. (took 6s5.362ms)
¥ K e
® | v
< » <
S IrrfBe3f ernmmar
Figure 8. Adding files in the MCUXpresso workspace

Use the core portme.c and core portme.h files provided with the application note and not the one from
the EEMBC CoreMark package. For convenience, these files have the required porting changes ready for use.

Copy these files to the CoreMark folder for all three toolchains and add the core portme. c file in the project
framework under the source group.

Several files must be modified to support CoreMark. They are described below.
In the project scatter file, change the stack size as 0x1000.

define symbol  size cstack = 0x1000;

define symbol  size heap  =0x1000;

To add the path to the header files used in the project, in Keil MDK under Project > Options > C/C++(AC6) tab,
click Include path and add the following paths that contain the header files.
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Device | Target | Output | Listing | User  C/C++ (ACE) | Asm | Linker | Debug | Ltites |

Preprd Folder Setup ?

[ Exa
Optimiz|
[~ Link

I Spl
¥ Onq

Setup Compiler Include Paths:

board

CMSIS
LPC55536/drivers
component lists
component.‘uart

device

drivers

startup

coremark

Mcoremark \port_lpc5500

DX [+

=-r T
4 I‘I

P

g
iy

Figure 9. Keil MDK compiler include paths

In IAR, under Project > Options > C/C++ Compiler, click Preprocessor, and add the following paths that contain
the header files.
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Options for node "lpc33s3x_coremark_iar” X
Category: Factomy Settings
General Options [] Multifile Compilation
Static Analysis Discard Unused Publics
Runtime Checking
Language 1 Language 2 Code Optimizations Output

Assembler List Preprocessor  Diagnostics Encodings Extra Options
Output Converter
Custom Build Dii s
E.u”d Actions Addttional include directories: fone per line)
Linker $PROJ_DIRS/drivers A
Debugger $PROJ_DIRS/startup

Simulator SPROJ_DIRS/tilties

CADI $PROJ_DIRS\coremark

CMSIS DAP SPROJ_DIRS \coremark \port_lpc5500 W

GDB Server Preinclude file:

Iet | [
J-Link/)-Trace '
TI Stellaris Defined symbols: (one per line)

Mu-Link DEBUG [ Preprocessor output to file

PE migo CPU_LPC55536JBD100 Preserve comments
STLINK RUN_ON_FLASH Generate Hine directives

COREMARK_SCORE_TEST

Third-Party Driver

TI MSP-FET

TI XD5

DK . Cancel
Figure 10. IAR EWARM compiler include paths

The CoreMark files have now been successfully ported into the CoreMark project framework.

In MCUXpresso, under "Properties for xxxx" > C/C++ Build > Settings >, click Includes and add the following

paths that contain the header files.
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. Properties for lpc33s36_ceremark

® Optimization
& Debugging
& Warnings

MCLUXpresso Cor
Project Natures
Project Reference
Run/Debug Settir
Task Tags

& Miscellaneous

& Architecture

@ TrustZone
~ B MCU Assembler

(@ General

2 Architecture & Headers
v % MCU Linker

& General

» Validation

& Libraries
@ Miscellaneous
(2 Shared Library Settings
(® Architecture
& Managed Linker Script
@ Multicore
2 TrustZone
v ® MCU Debugger
2 Debug

& Mizrellananus
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Figure 11. MCUXpresso compiler include paths

The CoreMark files have now been successfully ported into the CoreMark project framework.

2.1.2 CoreMark framework to execute from internal SRAM

The project 1pc55s3x _coremark sram executes the CoreMark application from the 16 kB
region.

SRAMX memory

The files core_list join.c, core main.c, core matrix.c, core state.c,and core util.c

are relocated to execute from SRAMX using the linker scripts.
For Keil MDK, the linker script is at: . \1pc55s3x coremark mdk\LPC55s36 sram.scft.

The linker script setting for the 1pc55s3x _coremark sram project is shown in Figure 12:

AN13579 All information provided in this document is subject to legal disclaimers.

© 2023 NXP B.V. All rights reserved.

Application note Rev. 3 — 23 November 2023

12/33



NXP Semiconductors AN1 3579

LPC553x/LPC55S3x CoreMark on Cortex-M33 Porting Guide

Options for Target 'lpc55s3x_coremark_sram'’ X

Device | Target I Output I Listing I User I C/C++ (ACG)] Asm  Linker I Debug ] Uilties |

[~ Use Memory Layout from Target Dialog X/O Base: I
[~ Make RW Sections Position Independent R/O Base: Iﬂ;mm}o
™ Make RO Sections Postion Independent R/W Base Imm

™ Dont Search Standard Libraries
[V Report ‘might fail' Conditions as Errors

disable Wamings: |5314

Scatt — ,
fer [\[PC55536_wam.sci =[] e |

Misc -Omax -info sizes -map —cpu=Cortex-M33 -fpu=FPv5-SP
controls
Linker |-cpu=Cortex-M33 *0o ~
control  |-ibrary_type=microlib -nodebug —diag_suppress 6314 —strict —scatter ".\LPC55536_sram scf"
string v
| ok || cance || Defauts | Help

Figure 12. Linker script in Keil IDE

For IAR EWARM IDE, to execute CoreMark in Internal SRAM and to place CoreMark operation codes into the
RAM section, add the following lines of code in the icf file, as shown in Figure 13:
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° Ipc55s3x_coremark_iar - IAR Embedded Workbench IDE - Arm 9.10.2

File Edit View Project CMSIS-DAP Tools

NR@ = XK 9cC

Window Help

-<Q >

-

=

<0 >0 RO

Workspace

v X

core_main.c | core_portme.c
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Files
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= M board

board.c

— R board.h
clock_config.c
— B clock_corfigh
in_mux.c
L— R pin_muxh

W CMSIS

1 W companent

M lists

core_portme.c
— B core_portme.h
core_state.c
[) core_util.c
— B coremark.h
ee_ptintt.c
£ i device

o

v

~

place in XCODE region
initialize by copy

place in XCODE region

initialize by copy

LPC55836_sramx.icf % LPC55536 flash.icf

{ section .critical code };
{ section .critical code };

{ rw object core portme.o,
rw object core main.o,
rw object core list join.o,
rw object core matrix.o,
1w object core state.o,
rw object core util.o,
rw object ee printf.o,

bi

{ object core portme.o,
object core main.o,
object core list join.o,
object core matrix.o,
object core state.o,
object core util.o,
object ee printf.o,

ba
T
ba

= = =

o

object powéd.o,
object strchr.o,
object strlen.o,

object powéd.o,
object strchr.o,
object strlen.o,
object ldexp.o,

object ldexp.o,
— R fs|_device_registersh . )i
| M| HACESAE L
|Ipc:5583x_covemark_iav < > v
Debug Log w o X
=

Ambiguous Definitions  Debug Log ' Build Find in Files

Ready

Figure 13. IAR EWARM allocate code to SRAM area

Ln 8, Col 49

System CAP NUM OVR BE=

For MCUXpresso to execute CoreMark in Internal SRAM, select the linker file as
LPC55s36 coremark run on sramx.ld in the Managed Linker script, as shown Figure 14:
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. Properties for lpc35s36_coremark O * ‘
type filter text Settings - -
Resoure . . ; —— _ -
B ?lzmw ® Tool Settings # Build steps ** Build Artifact & Binary Parsers © Error Parsers ~
uilders
w CfC++ Build ~ & MCU C Compiler [[IManage linker script
Build Variables ® Dialect Linker script |pc55536_coremark_run_on_sramxld
Environment Preprocessor Script path
Logging & Includes
MCL settings & Optimization Newlib (nohost)
Settings & Debugging
Tool Chain Edi # Warnings
C/C++ General # Miscellaneous ;
] or & Architecture
MCUXpresso Cor S ——
Project Matures & TrustZone
Project Reference ¥ ® MCU Assembler MCUXpresso Style
Run/Debug Settir & General .
Task Tags & Architecture & Headers
Validation v B MCU Linker Region Location Size
& General Heap Default Post Data Default
# Libraries Stack Default End Default

# Miscellaneous
(& Shared Library Settings
& Architecture

. Global data placement Default
1 Managed Linker Script P B
& Multicore Extra linker script input sections
& TrustZone Input section description Region Section Type
v & MCU Debugger
= Debug
# Miscellaneous
< > b
2 Apply and Close Cancel

Figure 14. MCUXpresso allocate code to SRAM area

2.2 Optimizing the CoreMark framework

Many factors affecting the CoreMark and yA/MHz score can be optimized. Some of these factors are IDE-
dependent optimizations, while others leverage the MCU architecture for better performance. The goal is to
be able to produce the best scores from all three IDEs. These IDEs are constantly changing and a different
version of a given IDE can add or remove features that can make these optimizations obsolete or ineffective.
The following are the IDE versions that are applicable to this application note:

Keil MDK v5.37
IAR EWARM 9.10.2
MCUXpresso 11.8.0

2.2.1 Memory considerations

Due to the inherent architecture of SRAM and flash, CoreMark executes faster when running out of SRAM.
The LPC553x/LPC55S3x internal memory uses a multilayer AHB matrix system that provides a separate
instruction and data bus for Cortex-M33 and SRAMX bank. See Figure 15. SRAMO to SRAM4 are on the
system bus. Placing the CoreMark code and data in different SRAM banks minimizes bus contention and
improves instruction and data parallelism.
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It is important to minimize the flash wait states according to the MCU frequency to optimize the CoreMark score.
In contrast, when performing the yJA/MHz test, it is possible to save power by disabling the flash prefetch ability.
The LPC553x/LPC55S3x User Manual contains more information on proper flash memory configuration, such
as the minimum number of wait states allowed at a given core frequency.

The provided CoreMark framework projects include separate SRAM and flash-based projects that implement

various memory optimizations.

@
'g >
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t 11 |~
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Coprocessﬁ; interface with | | Power control, BoD
math funcfion Power CAN| [USB- DC-DC Converter,
ARM Quad [[PMAO | DMAT Fo || Fs (DOs, FRO
Cortex M33 system functions PLL
g g g[ g
s 8 * g LPCAC | Flash | Flash
e U el I , (8k) |Mem Ctrl| 256 KB
i :
i i
: : Cathets -<—Flex-SPI >
! ! SRAMX
3 ! 16KB | sRAMO
i i SRAM 1 4x 4KB
| ! 16K8 | [sRAmS
3 ! SRAM 3| L32KB
! 1 S2K8 | [SRAMZ
3 R : 4x4KB
: ayer 1 DMAO USB-FS HS GPIO
i - ‘ 7 [ FSGPI0_J«>
i ]
! {[ DMIC ][ Debug |[CAN-FD|[ CRC Flexcomm 0-4 [1][«p>
i ' regs Mailbox || registers || engine
H ; T T T T Flexcomm 5-7 [1] |«>
! ]
; | [USBFS ][ Power Code HS SPI (Flexcomm 8)]«>
1 I | Hostregs || Quad Watchdog
} : I I I [ ADCO |4._
; | [ DMAT
! | | registers ADC1 —
i ! [ DAC(0,1,2) }H»
i ! [ OpAmp (0, 1, 2) >
! i
| | [ FlexSPT HSCMP (0, 1, 2) je—
i | regs
1 ; ENC (0, 1) L
i
| 1 AOT (0, 1) b
e ey e T ]
[APB bridge 0] [APB bridge 1] FlexPWM (0, 1) >
| 13C Je>f«>]  Multirate Timer ] [ PMC & ACMP Je>f«—>[  Flash Controller registers ]
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t _Event_
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Figure 15. LPC553x/LPC55S3x AHB matrix

Notes: [1] : each FlexComm includes USART, SPI, and 12C. Flexcomms 6 and 7 include 4 channel-pairs of 12S, Flexcomms 0-5 each include 1 channel-

In both the SRAM and flash projects, there is a COREMARK_SCORE_TEST macro defined in

core_ portme.h that indicates whether the project is configured to execute the CoreMark benchmark or the
MA/MHz test. If this macro is defined, the CoreMark score test runs. If this macro is commented out, yJA/MHz
test runs. Use this macro to switch between the two benchmark cases.
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2.2.2 IDE optimization setting

The following optimizations are compiler-based and therefore IDE dependent. These optimizations apply to both
the SRAM and flash-based projects.

2.2.2.1 Keil optimization

Two compiler optimizations can be done to improve CoreMark score and power consumption. In each
Coremark source code files’ Options and under the C/C++(ACB6) tab, the optimization level must be set as -
mcpu=Cortex-m33 --target=arm-arm-none-eabi -Omax -g -mthumb -mfpu=fpv5-sp-dlé6 -
mfloat-abi=hard -fno-common -ffp-mode=fast in Misc Controls.

KA options for File ‘core list join.c X
Propeties C/C++ (ACE) |

Preprocessor Symbols

e |

Undefine [

Language / Code Generation
[V Execute-only Code

Wamings: [anspecfied>  ~|  Language C: [<defaut> ~l

Optimization: | <default> | [¥ Tum Wamings into Eors

Language Cr+: [fads =]

[Z Link-Time Optimization
IV Split Load and Store Multiple
¥ One ELF Section per Function

[¥ Plain Charis Signed [ Short enums/wchar
[ Read-Only Posttion Independent [¥ use RTTI
[ Read-Wrte Postion Independent ¥ No Auto Includes

Include
e L
c w%:;‘; —sm-am-ione-ebi -Omax g _mthumb 4nfpu<pv5-5p-d16 4mfloat-abi-hard fno-common_fip-mode=fasi
Compler  [c std=c93 target-am = p— 13 mipudpv5epd16 mcatabihad <
W;t'o‘ no+tti funsigned-char

ng v

o] [ oen | [_owens |

Figure 16. Keil MDK CoreMark score optimization

2.2.2.2 |AR optimization

Two compiler optimizations can be done to improve CoreMark score and power consumption. Set the
optimization level to High, select Speed from the drop-down menu, and check the No size constraints

checkbox.
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Options for node "lpc55s3x_coremark_iar"

Categony:

[ Multi-file Compilation

Dizcard Unused Publics

General Options
Static Analysis
Runtime Checking
Assembler
Output Converter
Custom Build
Build Actions
Linker
Debugger
Simulator
CADI
CMSIS DAP
GDB Server
I-jet
J-Link/J-Trace
TI Stellaris
Nu-Link
PE micro
ST-LINK
Third-Party Driver
TI MSP-FET

List Preprocessor

Language 1 Language 2

) Medium

@®|High|
Speed v

No size constraints

Diagnostics

Factory Settings

Encodings Extra Options

Code Optimizations Output

Enabled transformations:

[»]Common subexpression elimination
[vILoop unrolling

[v]Function inlining

[v]Code motion

[ Type-based alias analysis

[ Static clustering

[“IInstruction scheduling
[IVectorization

TI XDS

oK Cancel

Figure 17. IAR EWARM CoreMark score optimization

2.2.2.3 MCUXpresso optimization

Two compiler optimizations can be done to improve CoreMark score and power consumption. Set the
optimization level to -O3. To do this, select Optimize most(-O3) from the drop-down menu.
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RE%iOu[CE % Tool Settings . Build steps * Build Artifact & Binary Parsers © Error Parsers ~
Builders ) .
~ C/C++ Build v ® MCU C Compiler Optimization Level Optimize most (-03) i
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Build Variables N Dialect Other optimization flags -fno-common
Enwvi 2nit & Preprocessor
n\nrclmmpn & ! [] Enable Link-time optimization (-flta)
Logging & Includes | | | |
— F—— at Ito objects (-fat-lto-objects
MCU settings & Optimization . . J
Settings (= Debugging [] Merge Identical Constants (-fmerge-constants)
Tool Chain Edi & Warnings Remove path from _FILE__ (-fmacro-prefix-map) | “./$(@D)/"=.
C/C++ General & Miscellaneous
MCUXpresso Cor & Architecture
Project Natures & TrustZone
Project Reference ¥ ® MCU Assembler
Run/Debug Settir & General
Task Tags & Architecture & Headers
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# Libraries

# Miscellaneous
® Shared Library Settings
& Architecture
2 Managed Linker Script
& Multicore
& TrustZone
v & MCU Debugger
& Debug
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() Apply and Close Cancel

Figure 18. MCUXpresso CoreMark score optimization

3 Measuring CoreMark on board

This section describes the specifics of measuring CoreMark on the LPCXpresso55S36 board.

3.1 LPCXpresso055S36 board

The LPCXpresso55S36 board supports VCOM serial port connection via J1. To observe debug messages from
the board, set the terminal program to the appropriate COM port and use the setting '115200-8-N-1-none'. To
make the debug messages easier to read, the new line receive setting must be set to automatic.

3.2 Board setup
The LPCXpresso55S36 development board is used for benchmarking.
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Figure 19. LPCXpresso055S36 development board

The board ships with CMSIS-DAP debug firmware programmed. For more information on CMSIS_DAP debug
firmware, see the following link.

For debugging and terminal debug messages, connect a USB cable to the P6 USB connector. Board
schematics are available on www.nxp.com.

3.2.1 pA/MHz measurement setup

To measure the LPC553x/LPC55S3x power consumption, remove the JP30 jumper and connect an ammeter
across the JP33, as shown in the picture below.

Note: The current data on EVK can be slightly higher than the data sheet due to more components that can
consume more power.
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Figure 20. pA/MHz measurement setup

Users can measure the current through JP33 by a multimeter.

When performing the yA/MHz benchmark, use the J2 USB connector to provide power to the board. Also,
after the yA/MHz benchmark project has been downloaded, debug the code in the IDE. Make sure to reset the
code with the software. Resetting the hardware generates sink current to MCU-Link, which lowers the current
measured from JP33 below the chip power consumption.

The core clock frequency can be changed by selecting a different configuration through the shell terminal by
MCU UARTO.

3.3 Run CoreMark code

The first step to get the CoreMark result is to connect the board’s connector J1 to the PC. Then the PC
recognizes the onboard MCU-Link debugger with a simulated serial port as shown in Figure 21. If the PC
cannot find the serial port driver, refer to the link to update the firmware on your PC.
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Figure 21. MCU-Link UCom Port

Open a UART debug terminal (Tera Term, putty, and so on) and configure it as 115200, 8 data bits, no parity, 1

stop bit, as shown in Figure 22.
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Port:

Speed

Data

Parity:

Stop bits:

Flow control:

Transmit

0

Tera Term: Serial port setup and connection

x|

COM23 v .

New setting
115200
8 bit s Cancel
none v
1 bit v Help
none v
delay
msecfchar 0 msec{line

Device Friendly Name: MCU-Link YCom Port [COMZ23)

Device Instance ID: USBA\VID_1FC9&PID_01438&8MI_02472D60E
Device Manufacturer: NXP
Provider Name: NXP
Driver Date: 9-9-2020
Driver Yersion: 1.0.0.0

Figure 22. UART debug terminal configuration

Once the necessary CoreMark files are added into the project (by following the Chapter 2.1 instructions),
compile the project and download to the LPCXpresso55S36 board:

* Click the Reset button as shown in Figure 23.
* The terminal displays the prompt information,
* The user can input ‘1’, ‘2’ from the PC keyboard to select the power source such as DC-DC or LDOcoreHP.
 After inputting a character, the terminal displays the frequency selection information, as in Figure 24.

* The user can input '1', '2', '3, '4' from the PC keyboard to select the frequency.

* After that, the program starts to test CoreMark, then waits 10 seconds or more.

* The CeMark benchmark prints on the terminal after a few seconds, as shown in Figure 25.

. COM23 - Tera Term VT

File Edit Setup Control

Window Help

Figure 23. CoreMark test core power source choose menu
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File Edit Setup Control Window Help

uithout cache

uithout cache

g sh without cache
ing on Flash without cache

Figure 24. CoreMark test core frequency choose menu

4 Result

Figure 25 and Figure 26 show the CoreMark benchmark result when running LPC553x/LPC55S3x at 12 MHz
core frequency in the MCUXpresso IDE. The CoreMark benchmark score is the number of iterations per
second. The CoreMark/MHz score executing from an internal flash for this run is 35.573392/12 MHz = 2.964
CoreMark/MHz.
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Figure 25. CoreMark result
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Figure 26. CoreMark result

Table 1 shows the typical CoreMark score when benchmarked on Keil MDK, IAR EWARM, and MCUXpresso
IDE running from internal flash and SRAM at 12 MHz core frequency.
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Table 1. LPCXpresso55S36 board CoreMark/MHz Score when 12 MHz

IDE LDO_CORE DC-DC
CoreMark/MHz CoreMark/MHz CoreMark/MHz CoreMark/MHz
Score(SRAMX) Score(Flash) Score(SRAMX) Score(Flash)
KEIL MDK cache enable [4.076 4.086 4.077 4.085
cache 3.804 3.806
disable
IAR EWARM cache enable 4.016 4.025 4.021 4.025
cache 3.795 3.795
disable
MCUXpresso cache enable |2.957 2.964 2.958 2.957
cache 2.839 2.839
disable

Table 2 shows the typical CoreMark score when benchmarked on Keil MDK, IAR EWARM, and MCUXpresso
IDE running from internal flash and SRAM at 96 MHz core frequency.

Table 2. LPCXpresso55S36 board CoreMark/MHz Score when 96 MHz

IDE LDO_CORE DC-DC
CoreMark/MHz CoreMark/MHz CoreMark/MHz CoreMark/MHz
Score(SRAMX) Score(Flash) Score(SRAMX) Score(Flash)
KEIL MDK cache 3.963 3.986 3.964 3.988
enable
cache 2.255 2.257
disable
IAR EWARM cache 4.017 4.023 4.018 4.023
enable
cache 2.471 2473
disable
MCUXpresso cache 2.955 2.956 2.956 2.956
enable
cache 2.024 2.026
disable

Table 3 shows typical CoreMark score when benchmarked on Keil MDK, IAR EWARM, and MCUXpresso IDE
running from internal flash and SRAM at 100 MHz core frequency.

Table 3. LPCXpresso55S36 board CoreMark/MHz Score when 100 MHz

AN13579
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IDE LDO_CORE DC-DC
CoreMark/MHz CoreMark/MHz CoreMark/MHz CoreMark/MHz
Score(SRAMX) Score(Flash) Score(SRAMX) Score(Flash)
KEIL MDK cache 3.949 3.972 3.951 3.974
enable
cache 2.248 2.249
disable
IAR EWARM cache 4.003 4.01 4.005 3.863
enable
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Table 3. LPCXpresso55S36 board CoreMark/MHz Score when 100 MHz...continued

IDE LDO_CORE DC-DC

CoreMark/MHz CoreMark/MHz CoreMark/MHz CoreMark/MHz
Score(SRAMX) Score(Flash) Score(SRAMX) Score(Flash)

cache 2.462 2.464

disable

MCUXpresso cache 2.945 2.945 2.946 2.946

enable

cache 2.017 2.019

disable

Table 4 shows typical CoreMark score when benchmarked on Keil MDK, IAR EWARM, and MCUXpresso IDE
running from internal flash and SRAM at 150 MHz core frequency.

Table 4. LPCXpresso55S36 board CoreMark/MHz Score when 150 MHz

IDE LDO_CORE DC-DC
CoreMark/MHz CoreMark/MHz CoreMark/MHz CoreMark/MHz
Score(SRAMX) Score(Flash) Score(SRAMX) Score(Flash)
KEIL MDK cache 3.873 3.905 3.875 3.906
enable
cache 1.754 1.755
disable
IAR EWARM cache 3.999 4.004 4.001 4.007
enable
cache 1.992 1.993
disable
MCUXpresso cache 2.942 2.942 2.944 2.943
enable
cache 1.688 1.690
disable

For yA/MHz, the following tables show typical results when running on the LPCXpresso55S36 board in LDO/
DCDC power source mode with VDD = 3.3 V at room temperature.

Note: The current data on EVK can be slightly higher or lower than in the data sheet, due to EVK having more
components can cause an increase in power consumption.

Note: The average current in T00MHz&150MHZz is higher than other modes, the reason is that those two
modes enable PLL, PLL causes an increase in power consumption.

Table 5. Keil MDK pA/MHz score (LDO_CORE)

Frequency Power consumption (mA, SRAM |Power consumption
X) (mA, Flash)
12 MHz cache enable 1.679 1.967
cache disable 2.093
96 MHz cache enable 8.4 10.296
cache disable 9.819
100 MHz cache enable 9.23 11.221
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Table 5. Keil MDK pA/MHz score (LDO_CORE)...continued

Frequency Power consumption (mA, SRAM |Power consumption
X) (mA, Flash)
cache disable 10.720
150 MHz cache enable 13.555 16.696
cache disable 14.812

Table 6. IAR EWARM pA/MHz score (LDO_CORE)

Frequency Power Consumption (mA, SRAM |Power Consumption
X) (mA, Flash)
12 MHz cache enable 1.890 1.884
cache disable 2.207
96 MHz cache enable 9.090 9.998
cache disable 9.493
100 MHz cache enable 9.800 10.884
cache disable 10.360
150 MHz cache enable 14.483 16.298
cache disable 14.344

Table 7. MCUXpresso pA/MHz score (LDO_CORE)

Frequency Power Consumption (mA, SRAM |Power Consumption
X) (mA, Flash)
12 MHz cache enable 1.715 1.872
cache disable 1.997
96 MHz cache enable 8.608 9.877
cache disable 9.435
100 MHz cache enable 9.441 10.78
cache disable 10.303
150 MHz cache enable 13.877 16.093
cache disable 14.282

Table 8. Keil MDK pA/MHz score (DC-DC)

Frequency Power Consumption (mA, SRAM |Power Consumption
X) (mA, Flash)
12 MHz cache enable 0.833 0.970
cache disable 1.032
96 MHz cache enable 3.286 4.148
cache disable 4.042
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Table 8. Keil MDK pA/MHz score (DC-DC) ...continued

Frequency Power Consumption (mA, SRAM |Power Consumption
X) (mA, Flash)
100 MHz cache enable 3.538 4.446
cache disable 4.332
150 MHz cache enable 5.799 7.366
cache disable 6.634

Table 9. IAR EWARM pA/MHz score (DC-DC)

Frequency Power Consumption (mA, SRAM |Power Consumption
X) (mA, Flash)
12 MHz cache enable 0.859 0.910
cache disable 0.978
96 MHz cache enable 3.485 3.871
cache disable 3.775
100 MHz cache enable 3.745 4.146
cache disable 4.046
150 MHz cache enable 6.181 6.951
cache disable 6.230

Table 10. MCUXpresso pA/MHz score (DC-DC)

Frequency Power Consumption (mA, SRAM |Power Consumption
X) (mA, Flash)
12 MHz cache enable 0.849 0.907
cache disable 0.966
96 MHz cache enable 3.363 3.827
cache disable 3.745
100 MHz cache enable 3.617 4.110
cache disable 4.015
150 MHz cache enable 5.931 6.870
cache disable 6.196

5 Conclusion

In this application note, three types of CoreMark benchmarking on the LPC553x/LPC55S3x are presented with
different IDEs (Keil, IAR, MCUXpresso): CoreMark score, power consumption, and yA/MHz. It also describes
how to optimize the benchmark results when running the benchmark from internal SRAM and flash.

The CoreMark results are measured on LPCXpresso55S36. The best CoreMark number is 4.085, achieved
by using KEIL MDK (Arm Compiler 6.14) and running CoreMark from flash with cache in DC-DC power source
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mode. The best CoreMark power consumption in yJA/MHz is 35.84. It is achieved by running CoreMark from
SRAM in DC-DC power source mode when the core frequency is 100 MHz.

6 Reference

» CoreMark Benchmarking for ARM Cortex Processors
* LPC5411x CoreMark Cortex-M4 Porting Guide (document AN11811)
* LPC5583x User Manual (document LPC553xRM)

7 Note about the source code in the document

Example code shown in this document has the following copyright and BSD-3-Clause license:

Copyright 2023 NXP Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials must be provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS I1S" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN

ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

8 Revision history

Table 11 summarizes the revisions done to this document.

Table 11. Revision history

Revision number Release date Description
3 23 November 2023 » Added Section 7
» Updated Figure 15
2 21 November 2023 * Updated SDK package from "SDK2.10" to "SDK2.14"

» Updated "Keil MDK v5.34" to "Keil MDK v5.37"
» Updated "MCUXpresso 11.4.0 Build[6237]" to "MCUXpresso

11.8.0"
1 26 May 2022 Replaced LPC55(S)3x with LPC553x/LPC55S3x
0 23 February 2022 Initial release
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Draft — A draft status on a document indicates that the content is still
under internal review and subject to formal approval, which may result
in modifications or additions. NXP Semiconductors does not give any
representations or warranties as to the accuracy or completeness of
information included in a draft version of a document and shall have no
liability for the consequences of use of such information.

Disclaimers

Limited warranty and liability — Information in this document is believed
to be accurate and reliable. However, NXP Semiconductors does not give
any representations or warranties, expressed or implied, as to the accuracy
or completeness of such information and shall have no liability for the
consequences of use of such information. NXP Semiconductors takes no
responsibility for the content in this document if provided by an information
source outside of NXP Semiconductors.

In no event shall NXP Semiconductors be liable for any indirect, incidental,
punitive, special or consequential damages (including - without limitation -
lost profits, lost savings, business interruption, costs related to the removal
or replacement of any products or rework charges) whether or not such
damages are based on tort (including negligence), warranty, breach of
contract or any other legal theory.

Notwithstanding any damages that customer might incur for any reason
whatsoever, NXP Semiconductors’ aggregate and cumulative liability
towards customer for the products described herein shall be limited in
accordance with the Terms and conditions of commercial sale of NXP
Semiconductors.

Right to make changes — NXP Semiconductors reserves the right to

make changes to information published in this document, including without
limitation specifications and product descriptions, at any time and without
notice. This document supersedes and replaces all information supplied prior
to the publication hereof.

Suitability for use — NXP Semiconductors products are not designed,
authorized or warranted to be suitable for use in life support, life-critical or
safety-critical systems or equipment, nor in applications where failure or
malfunction of an NXP Semiconductors product can reasonably be expected
to result in personal injury, death or severe property or environmental
damage. NXP Semiconductors and its suppliers accept no liability for
inclusion and/or use of NXP Semiconductors products in such equipment or
applications and therefore such inclusion and/or use is at the customer’s own
risk.

Applications — Applications that are described herein for any of these
products are for illustrative purposes only. NXP Semiconductors makes no
representation or warranty that such applications will be suitable for the
specified use without further testing or modification.

Customers are responsible for the design and operation of their
applications and products using NXP Semiconductors products, and NXP
Semiconductors accepts no liability for any assistance with applications or
customer product design. It is customer’s sole responsibility to determine
whether the NXP Semiconductors product is suitable and fit for the
customer’s applications and products planned, as well as for the planned
application and use of customer’s third party customer(s). Customers should
provide appropriate design and operating safeguards to minimize the risks
associated with their applications and products.

NXP Semiconductors does not accept any liability related to any default,
damage, costs or problem which is based on any weakness or default

in the customer’s applications or products, or the application or use by
customer’s third party customer(s). Customer is responsible for doing all
necessary testing for the customer’s applications and products using NXP
Semiconductors products in order to avoid a default of the applications
and the products or of the application or use by customer’s third party
customer(s). NXP does not accept any liability in this respect.
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Terms and conditions of commercial sale — NXP Semiconductors
products are sold subject to the general terms and conditions of commercial
sale, as published at https://www.nxp.com/profile/terms, unless otherwise
agreed in a valid written individual agreement. In case an individual
agreement is concluded only the terms and conditions of the respective
agreement shall apply. NXP Semiconductors hereby expressly objects to
applying the customer’s general terms and conditions with regard to the
purchase of NXP Semiconductors products by customer.

Export control — This document as well as the item(s) described herein
may be subject to export control regulations. Export might require a prior
authorization from competent authorities.

Suitability for use in non-automotive qualified products — Unless

this document expressly states that this specific NXP Semiconductors
product is automotive qualified, the product is not suitable for automotive
use. It is neither qualified nor tested in accordance with automotive testing
or application requirements. NXP Semiconductors accepts no liability for
inclusion and/or use of non-automotive qualified products in automotive
equipment or applications.

In the event that customer uses the product for design-in and use in
automotive applications to automotive specifications and standards,
customer (a) shall use the product without NXP Semiconductors’ warranty
of the product for such automotive applications, use and specifications, and
(b) whenever customer uses the product for automotive applications beyond
NXP Semiconductors’ specifications such use shall be solely at customer’s
own risk, and (c) customer fully indemnifies NXP Semiconductors for any
liability, damages or failed product claims resulting from customer design and
use of the product for automotive applications beyond NXP Semiconductors’
standard warranty and NXP Semiconductors’ product specifications.

Translations — A non-English (translated) version of a document, including
the legal information in that document, is for reference only. The English
version shall prevail in case of any discrepancy between the translated and
English versions.

Security — Customer understands that all NXP products may be subject to
unidentified vulnerabilities or may support established security standards or
specifications with known limitations. Customer is responsible for the design
and operation of its applications and products throughout their lifecycles

to reduce the effect of these vulnerabilities on customer’s applications

and products. Customer’s responsibility also extends to other open and/or
proprietary technologies supported by NXP products for use in customer’s
applications. NXP accepts no liability for any vulnerability. Customer should
regularly check security updates from NXP and follow up appropriately.
Customer shall select products with security features that best meet rules,
regulations, and standards of the intended application and make the
ultimate design decisions regarding its products and is solely responsible
for compliance with all legal, regulatory, and security related requirements
concerning its products, regardless of any information or support that may be
provided by NXP.

NXP has a Product Security Incident Response Team (PSIRT) (reachable
at PSIRT@nxp.com) that manages the investigation, reporting, and solution
release to security vulnerabilities of NXP products.

NXP B.V. — NXP B.V. is not an operating company and it does not distribute
or sell products.

Trademarks

Notice: All referenced brands, product names, service names, and

trademarks are the property of their respective owners.
NXP — wordmark and logo are trademarks of NXP B.V.
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AMBA, Arm, Arm7, Arm7TDMI, Arm9, Arm11, Artisan, big.LITTLE, IAR — is a trademark of IAR Systems AB.
Cordio, CoreLink, CoreSight, Cortex, DesignStart, DynamlQ, Jazelle,

Keil, Mali, Mbed, Mbed Enabled, NEON, POP, RealView, SecurCore,

Socrates, Thumb, TrustZone, ULINK, ULINK2, ULINK-ME, ULINK-

PLUS, ULINKpro, pVision, Versatile — are trademarks and/or registered

trademarks of Arm Limited (or its subsidiaries or affiliates) in the US and/or

elsewhere. The related technology may be protected by any or all of patents,

copyrights, designs and trade secrets. All rights reserved.
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